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Introduction

In this introductory course, we explore the EndNote X8 package. This course explores the
main features of the software from the creation of an EndNote library through to the
inserting citations into a Microsoft Word document. EndNote is a powerful tool for anyone
engaged in academic research, study and writing, during the course you will learn to use
the most useful features contained in the application.

Obijectives

On successful completion of this course, participants will be able to:

Create an EndNote Library

Add references manually

Import references from online databases

Import references using EndNote's Online Mode

Manage your references by and creating and using groups
Attach PDF documents to your references library

Check for and remove duplicates from in your EndNote library
Cite your references when writing in Word

Change citation styles within a Word document.

Introduction to EndNote Desktop V1.1 iii



Introduction to EndNote Desktop

1

What is EndNote?

EndNote is a reference management application, which is used to manage bibliographies
and references when writing theses, essays and articles. The software is available for both
PC and Mac.

EndNote allows you to:

. Store all the references that you find during your research. They can be entered
manually or downloaded from most databases.

. Store PDF files, pictures, graphs, tables, etc.

° Add citations to your work and create bibliographies in any output style (e.g.
Harvard, Vancouver). There are 5,000 styles to choose from.

How to obtain EndNote

Preinstalled
It is preinstalled on:

. Student computer clusters (CSCE)
. Students: CSCE Remote- Remote Desktop service
. Staff: SSD Remote- Remote Desktop service - for Standard Staff Desktop users

SSD users can upgrade to the latest version of EndNote, (see c. Download from University
website)

Purchase from Bilaney Consultants

Students are able to purchase the software at a discount from here:
https://www.bilaney-consultants.co.uk/our-products/endnote.html

For each licence purchased, EndNote X8 may be installed on up to 3 computers (both
Mac and Windows) for exclusive use by the licence holder. All licences are a one-off
purchase (not subscription).

Download from University website

Staff and postgraduate students are able to install endnote free, though only for use on
University owned/operated machines.

You must register before downloading. Registration and download links are found at:
https://www.gla.ac.uk/myglasgow/it/software/bibliographic/#/endnote

If you have an earlier version of EndNote you should uninstall it before installing
EndNote X8.
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The EndNote Library

Introduction

EndNote references are stored in a database called a library. EndNote ﬂ
libraries have the file extension .enl

Each library has a corresponding folder with the extension .Data. This et

folder will have the same name as the library, and it is where images,

PDF files, etc. are stored. If you move, copy, rename or delete a Library

remember to do the same with its corresponding .Data folder.

E

o You are not limited to the number of references you can store in a My EndiNote
library. However, it is recommended that you do not exceed e
100,000 references to maintain efficient performance of the database.

. Although the software allows you to create as many libraries as you wish, it is

strongly recommended that you keep all your references in just one library. This way

you will know where to find them, and will not create duplicate records in other
Libraries.

. Within your library, you can create Groups (or subsets) to help you organise your
references. Custom Groups are manually created by drag-and-dropping to copy
references into a Group.

. You can also create Smart Groups that use search criteria and dynamically update

themselves.
° Each EndNote record stores the information required to reference it in a

Bibliography. Other information, to help you with your research, such as keywords,

notes, abstracts and URLs can be stored in a record as well.
. You can attach PDF files and images to EndNote records, and you can annotate
PDFs with highlights and your own comments.

Creating an EndNote Library

Endnote libraries are the files that store your references, PDFs and other data. You may
store your library wherever you think it is most useful to you. However when considering a
suitable location for storing your library, think about where is easily accessible and easiest

for creating back-ups.

Although we can synchronise this local library with the online library of EndNote Basic, this

iS not a substitute to having a sensible and durable backup regime.

Task 1. Create an Endnote Library

1 Choose File Menu, New...

Edit References Groups Tools Window Help

ew.
[gpen Library... Ctrl+0
Open Shared Library... Ctrtl+Shift+0
Open Recent 3

2 Accept the default name My Endnote Library

3 Click Save
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4 Once saved it will open automatically

5 If you need to click on the maximise button on the top left of the open library so that
your open library fills the screen.

Although your library should open automatically when you create it, you may in the future
need to open a library. This is done from the file menu by selecting:

File > Open > Open Library
c. Library Overview

Once you have created a library

@ EndNote X8 - [My EndNote Library.i
@(File] Edit References Groups Tools Window Help

E New... '% & [e ] S wE | 0 0 | | ouice searcn C_ . 7 Hide Search Panel
Open Librarjs:
My Open Shared Library... Ctrtl Shift+0 Go to File, New to make a new atch Case [ Match Words
@ e ' =] cori Library, or Open to open an BE -
Z Clase ibrany CrrleW .. . ————
existing Library
\. J

The Endnote Library window is split into 3 panes:- Groups pane, Reference List pane
and Tabs pane

1 The Reference List pane

This shows a list of all your references, each displaying as a single
line. You can sort the references by clicking on a column heading

@ EndNote X8 - (M) / Lo | )
@ File Edit References Groups Tools - || %
p:
= = »
@@ Harvard &l ‘ 2l =) =) B E’E| (55 2 - ®| Quick Search a -
=
My Library | Search arch Whole Library »  [[|Match Case [T Match Words Reference | Preview @—tta-:he-:l PDFs 5
All References @ »
E Autho! * Contains - E] i Reference Type: Book -
@Sync Status... \ / X
D) Recently Added 0 |® @ Author B Mo References Seledled
Bl Unfiled @

= Research notes
=~ My Groups

=~ Find Full Text

2 The Groups pane

These are subsets (or Folders) of
references saved for easy retrieval. 3 The Tabs pane !
Click on the title of a group to see its
contents displayed in the Reference
List pane

This includes tabs to three commonly
used functions — Reference, Preview
/ and Attached PDF

T
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d. EndNOte MOdeS @@ @” Harvard

EndNote has three display modes: My Library
i ; All Ref 0
. Local Library (Folder icon) gs S:r:”ces
. Online Search (Globe icon) . yne Status..,
. Integrated (Folder & Globe icon) D Recently Added (0}
B Unfiled )

These are displayed in the top left corner of EndNote ilﬁu_ﬂ
above My Library

Local Library displays all of the records held in your EndNote database.

Online Search Mode is a temporary library that will display the results of online searches
from within EndNote. Results from these searches are not added to your local library.
These results can be reviewed and then selected references can be added to your library.

Integrated Library and Online Search Mode will automatically import all of the results
from an online search into your local library and mark them as ‘unfiled’. Use this mode
with caution!

e. Reference Overview

Fraser, 0. M.; Bug... 2011 Ravens reconcile after aggressive conflicts with v... 7 7
Funk, M. 5, 2002 Problem solving skills in young yellow-crowned ...

Goto, K.; Watana... 2012 Large-billed crows (Corvus macrerhynchos) have...
Greenhall, Art

House bat management

To see all the details for a reference, you can either use
the Reference tab, or double click on the Reference in

these numbers for formatting and they cannot be changed you need to change

ﬁ - case — eg., for titles

p
Each Reference has its own unique number. EndNote uses ] Use the Aa button if

@ EndNote X8 - [Speirits, 2014‘5] \ Imported n a” caps

@ File Edit References Groups Tools Window Help 7

4m wp Reference Med PDFs | 2 -
E| e 5| E|%| G| 5| Fanr Jpansze - B T U P|AYA T A ME S48 vl O @ -
e = |"\ There are no PDFs attached to this reference.

Author Sho

Speirits, F. C. Show Ra

Lavery, M.P. ). .

Padgett, M. ).

Barnett, 5. M.

tear The font and size should both be set as

Tidle Plain, unless you need a special style for a

e smouermemenm®] - character. You do NOT need to set italics or Use the Options

Optics Letters bold; EndNote will do this for you button to hide or

Volume . .

39 display empty fields

e in the record and

Pages display the Ratings

2944-2946

Start Page tool

pub Date When you are typing in numbers,

eg., for pages or volumes, you

Date

W 15 do not need to type v. or pp. |

e before them — just the numbers

Added to Library: 10/10/2017  Last Updated:lt\ } Layout ~
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@ EndNote X8 - [Speirits, 2014 #55] = | B | |

@ File Edit References Groups Tools Window Help _ &=
Reference L 01-38-10-2944 pdf ‘ @ 5
E|@ &

Abstract
I is well established that light carrying orbital angular momentum (OAM) can be used to induce 3 mechanical torque causing an object to spin.
We consider the complementary scenario: will an observer spinning relative to the beam axis measure a change in OAM as a result of their
rotational velocity? Remarkably, although a lincar Doppler shift changes the lingar momentum of a photon, the angular Doppler shift induces no
change in the angular momentum. Further, we examine the rotational Doppler shift in frequency imparted to the incident light due to the relative
motien of the beam with respect to the ebserver and consider what must happen te the measured wavelength if the speed of light ¢ is to remain
constant. We show specifically that the OAM of the incident beam is not affected by the rotating observer and that the measured wavelength is
shifted by a facter equal and eppesite te that of the frequency shift induced by the rotational Doppler effect. (C) 2014 Optical Socicty of America

@‘%|®‘@@|P\amﬁnt - pansize ~| B T QE]‘AIAJ_ZA' IC= @IZ”UQI 3‘@@62% -7

m

Notes

Aibki

Times Cited:8

Cited References Count:14

Research Notes

URL
«Go to 151>:/ 5:000336882500031
httpe://w blishing.org/ol/abstract.cfm?uri=ol-39-10-2944

File Attachments
ol-39-10-2...

Author Address
Univ Glasgow, Sch Phys & Astron, Glasgow G

m

Figure

As well as the fields which are
required to format your
Bibliography, EndNote provides a
number of fields for your own use,
eg., to write your own research
notes, attach files and images

Caption

Added to Library: 10/10/2017  Last Updated: 10/10/2017 Layout -

- J

EndNote X8 has 50 predefined reference types that it can store. Records imported
automatically from databases will usually have the correct reference type selected, but
occasionally you will need to change it to achieve a better citation.

EndNote has some features to help with your information management. When you import
records into EndNote they will be displayed in bold (unread). To help you keep track of
your workload you can mark records when you have read them, and also assign a rating
to remind yourself how useful you found the paper.

4 Adding references using EndNote

a. Manual Input

Usually, References will be added to your Library by importing them directly from online
databases, but occasionally you will need to make a manual record — for example, for a
webpage, blog or unpublished report that does not have an electronic record for it.

@ EndNote X8 - [My EndNote Library.eni] SRACH X

© File Edit References Groups Tools Window Help ==

E® G| e | EER SR F e[ B | (IR %] @ e o

My Library ® @ Author Year  Title ce | Preview ‘@ul-ss-m-zsaa.paf|@ 4 » 3
@ speirits, F. C; Lavery, M. P Bamett, 5. M. 2014 Optical angularn

FE@R| 4o =e”

El Copied References w

(@ Sync Status... " 'up“";lw;mmm -
oy A " Click the New Reference button —a “

blank form will be displayed
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@ EndNote X8 - [New Reference] [=] & [tz

@ File Edit References Groups Tools Window Help _=]x

Reference ‘ L Attached PDFs | @ =

‘E|%‘®‘@@‘Plammt - painsize - | B T u@| A A L - | -J‘ .|”

Reference Type: Book 'ré o

EndNote 101
Series Editor

Series Title

Place Published

University of Glasgow Press

Number of Volumes
Series Volume

Number of Pages

» | | There are no PDFs attached to this reference.

Select the correct Reference Type

Remember that EndNote will do any standard formatting automatically so set Plain
Font and Plain Size

Type the information into the relevant fields.

(Most of the fields you need to produce an adequate citation are towards the top of
the page)

Click the Close button to save the reference

The first time you attempt to close the reference-editing screen, you will be prompted
with a message that asks you if you wish to save the reference.

If you select the tick box before you answer yes, then this will be the last time that
you see this dialogue box. Manually created or edited references will be saved
automatically whenever you close the dialogue box.

Many of the fields are provided to help you organise your research, make useful
notes, etc. You do not have to fill them all in.

Sometimes, you will also need to edit records that you have imported from databases. In
this case double click a reference to edit.

Task 2. Manually Create References

With your existing library:

Manually create a new reference for a book e.g.

Author: Nixon, William

Year: 2014

Title: EndNote 101

Publisher: University of Glasgow Press
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2 Manually create a new reference for a journal article e.g.

Author: Harriman-Hunter, Judith

Year: 2014

Title: Using EndNote for bibliographies
Journal: Journal of Bibliographies
Volume: 1

Issue: 1

Pages: 100-110

ISSN 1234-1234

3 Manually create a new reference for a book section e.g.
Author:  Nixon, William

Year: 2014

Title: Importing EndNote from Web of Science
Editor: Harriman-Hunter, Judith

Book Title: EndNote and Beyond

Place: Glasgow

Publisher: University of Glasgow Press

4 Create a number of other manual references; try different Reference Types to see
the range of fields

5 Select the EndNote 101 reference that you created.

6 If you need to click on the Reference tab in the tabs pane (it will probably already be
selected)

7 Click on the Place Published field in the tabs pane
8 Type in Glasgow

9 Select any other reference

When you edit a reference in the tabs pane, the changes that you make are automatically
saved at the point that you click on another reference.

b. Importing References

When you search databases to find journal articles, books and other material there will
usually be options to export the results of your search so that you can import references
into your own EndNote Library. In many cases, it is possible to import these results directly
into EndNote. Otherwise, you can usually export them to a file, and open that file (either
automatically or manually) within Endnote.
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Many databases have an export, save or download option that will send your search
results directly to EndNote. All you need to do is choose the EndNote Library into which
the data should be imported.

In a few databases, importing records is a two-step process where you save the results of
your search into a file, then import that file into your EndNote Library using an Import
Filter.

Note that not all databases will have an option to export records to EndNote. In those
cases, you can try exporting the references in another format (i.e. Bibtex). EndNote is
able to read and import from many other reference library files. It will, on occasions still be
necessary to add details of those references manually to your library, as described in the
previous section.

Online Search Mode

EndNote also provides an “Online Search Mode” which enables you to search for articles
from EndNote itself. You may find this mode especially useful when you already know the
book, journal article etc., that you wish to reference.

EndNote is able to connect to a whole host of online catalogs and resources.

Note however that the University does not have access to every one of the nearly 6,000
resources that EndNote can connect too.

Task 3: Import references with Online Search Mode

1 Click on the Globe icon in the top left to enter Online Search mode.

A number of resources are displayed including the Web of Science Core Collection
and an option for more...

In this example, we are going to search for examples of articles written by Padgett
published in 2013.

2 Click on Web of Science Core Collection

@ EndMote X8 - [Online Mode]

@ File Edit References Groups

M | Harvard

My Library § ‘

I& Online References 0)
Online Trash

=+ Online Search
@"Web of Science Core..  (0)
3, CINAHL (EBSCO) )

More...

3 In the search box, type the following:
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@ EndNote X8 - [Online Mode]

@ File Edit References Groups Tools Window Help

D@ | renara  BEQLECA| @S| B

L/ Jg ~0 -

® | Quick Search

My Library | Search Options * Search Remote Library - Match Case Match Wards
& Online References @)
— Authar (Smith, &, B - Contains B P2 et =
(1] Online Trash W]

And w  Year (limiter only) * Contains - |2014 B

And w  Title v  Contains - | HE

=)~ Online Search

@CINAHL (EBSCO) (0]

=

® & Author Year Title

maore...

Author: Padgett
Year: 2014

4 Click on Search

EndNote will do this search, report on the number of records found and ask for
confirmation.

Confirm Online Search @

Found 151 records.

Retrieve records from: 1 through 151

Clear currently displayed results before retrieving records.

[ OK ] [ Cancel ]

b

Downloading the results of an online search can take some time. If the number of
records found is in very large, you will probably wish to cancel the search at this
point and revise the search criteria you have used.

5 Click on OK and the results will be displayed in EndNote.

@ EndNote X8 - [Online Mode] SNACE X |
© File Edit References Groups Tools Window Help _[=]x
r__| Harvard - E& & & & .";‘ BB W) S Ca - ®| Quick Search Q ~ A Hide Search Panel
My Library || [ searen Options Search Remote Library + [IMatchCase [ |MatchWords | Reference [ Preview |attached PDFs | @2 =

Online Ref 51, >
EOH\WT Tnm & (Uj Author [Smith, A, B} ~  Contains - [Padgett E] Reference Type: Journal Article -
T Online Tras!

And v Year imiter only) +  Contains - [o01e [=] ||| No References Selected
I=} Online Search
And > Title ~ Contains - +
Web of Science Co... | E]

€3, INAHL (EBSCO) ©

more ® @ Author Year  Title -
L ] Wang, Z. H.; Duenas-Osorio, L.; Padgett, J. E. 2014 Risk-based combination of earthquake and scour |
®  Caprani C.C; Ghosh, J; Padgett, J.E. 2014 Influence of live loads on component and system |
®  Kameshwar, S, Padgett, L.E. 2014 Multi-hazard reliability analysis of bridges based uj
[ ] Attarian, A; Danis, G.; Gronsbell, .; lervolino, G; la.. 2014 Baseball pitch classification: A Bayesian method an
®  Salkeld, D. J; Castro, M. B Bonills, D Kjemtrup, A;. 2014  Seasonal activity patterns of the western black-le
[ ] Yan, ¥.; Xie, G. D.; Huang, H.; Lavery, M. J; Ahemd, .. 2014 Demonstration of 8-Mode 32-Gbit/s Millimeter-W
®  Wang.Z H; Padgett, J. E; Duenas-Osorio, L. 2014 Toward a uniform seismic risk design of reinforce:
L ] Xie, ¥. T.; Htwe, Y. M.; Padgett, J.; Henschke, C; Yan... 2014 Automated aortic calcification detection in low-dc
®  Dudley. A; Mafu, M: Goyal, 5.; Glovannini, D; Mcla.. 2014  Encoding mutually unbiased bases in orbital angula
° Mclaren, M Mhlanga, T.; Padgett, M. J; Roux, F.S;.. 2014  Recovery of quantum-entanglement after encour
[ ] Rasouli, M. R; Gomes, L. S. M_; Parsley, B.; Barsoum,... 2014 Blood Conservation
®  Malik M; Mirhosseini, M; Lavery, M.P. J; Leach, J; . 2014  Direct measurement of a 27-dimensional orbital-s
® Abdel, M. P; Heyse, T. J; Elpers, M. E; Mayman, D. ). 2014  Ceramic Liner Fractures Presenting as Squeaking
®  Bowman, R.W; Gibson, G. M; Linnenberger, A; Phi.. 2014  "Red Tweezers": Fast, customisable hologram gen
L ] Henwood, B. F.; Padgett, D. K;; Tiderington, E. 2014 Provider Views of Harm Reduction Versus Abstin(|E ‘
®  Moura-Leite, R C; Padgett. R. C.; Galan. L. L 2014 Stakeholder Management and Nonparticipation in ~
< i v

Showing 151 of 151 references in Group. (All References: 151) =] tayout ~

Note that these are not copied into your local Library in this mode.
6 Sort the results by Title by clicking on the Title column heading

7 Select “Optical angular momentum in a rotating frame” with a single click
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8 Right click and use the Copy Reference to command to copy this to your library.
9 Holding the Control key and single click multiple other references

10  Click the Copy to Local Library button in the EndNote Toolbar

@ EndMote X8 - [Cnline Mode]

@ File Edit References Groups Tools Window Hel
P p

D@‘ Harvard ~ '__"‘ Iil |:;‘I I‘EI
My Library ' | [ Search L Copy to Local Library [

EOnIine References (151) In Online Search Mode, copy the selected records to your Local Library.

Ndbhar

=l| 4L o4n (L) N M+ &y
= v (& V)28 o

Either of these methods will make a copy of a reference or references in your local
library

Task 4: Use the University of Glasgow Library Catalogue

In our previous task, we used the Web of Science Connection file to search that catalog.
Now we shall use a connection file for the University of Glasgow’s Library catalogue.

With EndNote open and in Online Library Mode:

1 Click on more...

The Choose a Connection dialogue box will open

2 Either:
-
Choase A Connection @
Name Information Provider 0
U Exeter Library Catalogs
U Florida Library Catalogs
U Freiburg Library Catalogs
U Fribourg Library Catalogs
U Geneve Library Catalogs
U Georgia Library Catalogs
U Glasgow Library Catalogs
U Goettingen Library Catalogs
U Guelph Library Catalogs B
U Hamburg Library Catalogs
U Hawaii-Manoa Library Catalogs
U Helsinki Library Catalogs
11 Ui W Ly Cmbmlame a0
Quick Search - Eind by *
File Name: U Glasgow.enz
Created: 06 October 2017, 11:29:36
Modified: 29 September 2010, 11:11:10

Based On: INMOPAC

Category: Library Catalogs
Comments: |The holdings of the library of the University of Glasgow =

may also be found in the COPAC database (also included
with EndMNotel, S
Showing 438 of 438 connection files.
h

Alternatively:

Type Glasgow into the Quick Search box and click Enter
3 Select U Glasgow

4 Click Choose.
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It will now be displayed as U Glasgow in Online Search.

5 Select U Glasgow in the left hand pane

My Library ) |
EOnIine References (151
"L-I"OnlineTrash (0)

= Online Search
'ﬁWeb of Science Co... (151)

'ﬁ CINAHL (EBSCQ) ()]

The search terms from our previous task will still be present. To remove them:
6 Click Options

7 Select Restore Default

r.—.' Save Search l
Tools Window Help Load Search

T

Set Default
Rest{~g Default

5 roup
Author Convert to Smart Group

And =  Author/Title/Subje Tab

Carriage Return
And w  Title

Pause

8 Run a search for author, Hemingway, E (Confirm the search when prompted)
9 Double-click on “Complete Poems” to see the full record,

10  Scroll down and you will see the Library call number and the status at the time of the
search.

Accession Number
Call Number

Library Level @ English XE2901 1992-G In Library
Label

!(egrwords
11 Close the reference
12  Copy it to your library.

13  Try a number of searches using Online Search Mode to add records to your Library

5 Importing References from the Web

It will often be preferable to import references from web based online catalogues rather
than use EndNote's own online mode. This may be because the data store you are using
is not accessible via online mode, or possibly the web based interface offers you better
search results and search tools
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Each web-based resource (such as Web of Science, SCOPUS, PubMed, etc.) will have its
unique layout and features. It is not possible within this course to look at all of them, but
almost all will have the ability to export references in a file that can be read by EndNote.
We will look at two examples

Importing from Web of Science

The Web of Science database is owned by the same company as EndNote (Clarivate
Analytics), and they work well together.

References can be exported directly from Web of Knowledge to EndNote Basic (the web-
based version) or to EndNote Desktop. Records exported to EndNote Basic can by synced
with EndNote Desktop.

Getting started with Web of Science (formerly Web of Knowledge)
1 Navigate to the Library Homepage (https://www.gla.ac.uk/myglasgow/library/)

2 From the Library home page, click on Databases by name from the Specific
search group

Specific search
— Articles
— Books

— Databases by subject

= Databases'hb name

3 Use the search tool to find Web of Science

DATABASES BY NAME

Searching by Name

web of science| Sorted by Relevance M

4 From the search results select Web of Science — Core Collection — Connect

2 Web of Science - Core Collection : Web of Science - Core Collection; C%?ne,ct 1

5 Log in to the Web of Science database, you will need to provide your GUID and
password to get connected

6 Type in your search terms e.g. Heisenberg principle and click on Search

Basic Search Cited Reference Search Advanced Search + More

heisenberg principle| Topic v m

+ Add Another Field Reset Form

7 From the list of results mark the records you want to export

Introduction to EndNote Desktop V1.1 12



InCites | Journal Citation Reports | Essential Science Indicators | EndNote | Publons signin Help | English

13 Clarivate

Analytics

My Tools ~  Search History ~ Marked List
Results: 1’,921 . Sortby:  Publication Date — newest to oldest - 4 Page |1 of 193 P
(from Web of Science Care Collection)

You searched for: TOPIC: (heisenb
erg principle) ..More

Select Page E“ = 5K Save to EndNote online v Add to Marked List ilil Create Citation Report
& Create Alert = Analyze Results
1. Unis of positive i to some Times Cited: 0
B Wan v N (from Web of Science Core
= y: Wan, Youyan; Xiang, Chang-Lin Collection)
DEfneitesultz JOURNAL OF MATHEMATICAL ANALY SIS AND APPLICATIONS Volume: 455 Issue: 1-2 Pages: 1835-1847
Published: NOV 15 2017 Usage Count~
Full Text| Full Text from Publisher View Abstract
Search within results for...
¥ 2 Tuning magnetic properties of Cr2M2C3T2 (M = Ti and V) using extensile strain Times Cited: 0
(from Web of Science Core
TTEaTams By: Yang, Jianhui; Luo, Xuepiao; Zhou, Xumeng; et al Collection)
v COMPUTATIONAL MATERIALS SCIENCE Volume: 139 Pages: 313-319 Published: NOV 2017
Highly Gited in Field (21) ‘W Full Text| Full Text from Publisher View Abstract Usage Count~
Refine
3 Geographic spatiotemporal big data correlation analysis via the Hilbert-Huang transformation Times Cited: 0
- ) (from Web of Science Core
Publication Years v By: Seng, Weijing; Wang, Lizhe; Xiang, Yang; et al. Collection)
Select Page |E| B 5K | Save to EndNote online a I Add to Marked List

Save to EndNote online

¥/ 1. Unigueness of positive soluti |5*“’e to EndNote deskiop I ams

By: Wan, Youyan; Xiang, Chang-Lir Save to ResearcherlD - Twrote these
JOURNAL OF MATHEMATICAL  5ave to InCites ne: 455 lssue: 1-2 Pages: 1835-1847
Published: NCV 15 2017

= Save to Other File Formats
Full Text| Full Textfrom

9 Choose record content, in this case Author, Title, Source and Abstract then click
on Send

Send to EndNote ‘

3 records selected

Record Content: [ author, Title, Source, Abstract -]
Author, Title, Source
Author, Title, Source, Abstract
Full Record W
Full Record and Cited References

10  Double Click on the .ciw file that downloads in your browser

11 The downloaded records should import directly into EndNote and will go into an
Imported References group in EndNote Desktop.

@ File Edit References Groups  Tools  Window  Help

EQRIER| 0|05 (0L | @ wse
Search Search Whole Group » [[IMatchCase [[]Match words
&

@@ @| Harvard -

My Library

& All References 3]

Author ¥ Contains A

Imported References

|
(D) Sync Status... And - [ Year ~ Contains vl B
|

@ Recently Added (€3] And w  Title * Contains - B

Bl Unfiled [€)]

mTrash 0 |® & Author = Year Title

O Research nates L ] Song, W. J.; Wang, L. Z; Xiang, ¥.; Zomaya, A. Y. 2017 ‘Geographic spatiotemporal big data correlation analy
B Ardui © L ] Wan, Y. ¥; Xiang, C. L. 2017 Uniqueness of positive solutions to some nonlinear N
it [ ] Yang. ). H.; Luo, X. P.; Zhou, X. M.; Zhang. 5. Z; Liu, ). 2017  Tuning magnetic properties of Cr2M2C3T2 (M = Tian

(= Mw Grouns

12  If they do not, you will need to use File > Import > File and import the records from
your Downloads folder, by default Web of Science records, for EndNote Desktop are
exported as savedrecs.ciw.
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b. Importing from Article Search

For our second example, we will import references from the Glasgow University Library
website.

Task 5: Import References from the Library Web Catalogue
1 Open Google Chrome
2 Navigate to https://www.gla.ac.uk/myglasgow/library/

3 In the Search tool, type Heisenberg principle

LIBRARY

Search the Library's print and online resources

heisenberg Drinc‘ple

Advanced search

4 Click Search
Your results will appear in the browser

5 For any of the results in the browser, click the ellipses on the right hand side.

40,412 results sorted by relevance = % Add results beyond your library's col MI_)[E
actions
online. P . N &
1 el Unifying decoherence and the Heisenberg Principle {':')
by Janssens. Bas Read Online
Letters in Mathematical Physics, 08/2017, Velume 107, Issue &
.... This gives a unified description of both the Heisenberg uncertainty principle and the collapse of the Expart to
wave function RefWorks
Journal Article: Full Text Online EasyBib
Open Access
P Preview ~ EndNote
Zotero
BibTeX
P Reducing Uncertainty: Implementation of Heisenberg Principle to Measure Company Citavi

Performance
-

Arnn Puicinn Flana Fadann e Clans Ghocdinn

6 From the drop down menu that appears select EndNote

7 Click on the file that downloads (it should appear in the bottom left hand corner of
the browser)

e | export—endnotet}‘is His—

8 Select the Chrome icon from your Windows Task Bar

You will return to your web search results

9 In the results page click on the folder to the right of a different record

The folder icon will change colour
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10

11

12
13
14

@M = %

Repeat this for more records

As you select records you will see the total number of records displayed in the folder
in the top right.

heisenberg principle Q Advanced ~

Click on the folder to see the saved items.
Click the Export To... button

Choose EndNote as the export format.

-

As shown on search results

RefWorks
Heisenberg's uncertainty principle EasyBib
by Busch. Paul; Heinonen. Teiko; Lahti, Pekka EndNote
Physics Reports, 2007, Volume 452, Issue 6 Zoter
... that Heisenberg's uncertainty principle, s gipTex squality for
position and momentum, (1)Aq-Apzh ., e Citavi even in the
itavi
eyes...

Journal Article: Full Text Online

15 Click on the file that downloads

2| export-endnote-15.. ¢
port-endnol

16  Follow the instructions to import the references

If the records are not automatically imported into EndNote when you click on the
downloaded files, they can be imported with the Reference Manager (RIS) option.

Import File: I

Import Option: Reference Manager (RIS)

Duplicates: [Impcrt into Duplicates Library

Text Translation: [NO Translation

Introduct
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Organising your References

Using Groups

Groups make it easy to break a large Library into subsets for later viewing. A group simply
points to a subset of references that already exist in the Library.

There are several types of groups that make it easy to organise your references in
EndNote. Some of these groups are automatically generated and some are those you
create yourself. You can further organise your references by storing multiple groups in
custom Group Sets.

Some things to note about using groups:

o You can create a maximum of 500 Custom Groups and Smart Groups (combined) in
a single Library.

° A single reference will never appear more than once in a particular group. However,
you can add that reference to any number of groups.

. Removing a reference from a custom group does not delete it from the Library. It
removes the reference from the group subset, but the reference still exists in the
Library.

o Deleting a reference from a Library also deletes it from all groups in that Library. The
reference no longer exists.

° Custom groups will transfer and be visible in both the Desktop and Basic (online)
versions of EndNote

. Group Sets, Smart Groups and other automatically generated groups will not appear
when you are using the Basic (online) version of the product

Creating a Custom Group

You can create custom groups in order to organise your references. You might wish to
make groups for each chapter of your thesis, or for different papers you are working on.

Task 6: Create a Set of Custom Groups

1 Click on the folder icon to enter Local Library Mode
RS EN.

D Local Library Mode
Display local library (do not display Online Search results).

2 Go to the Groups menu and choose Create Group Set

Harvard -

@ EndNote X8 - [My EndNote Library.enl] p— .“-
@ File Edit References | Groups | Tools Window Help
B®

Create Smart Group
My Library

Harvard Create Group ’;

Create From Groups...

EAII References "
R Group b

ER Copied References SRS |

Edit Group...
.!,Imported References HIRERRE ;t

Delete Group
@S)rnc Status... AR ot

@ Recently Added Add References To 3
E_!Unfiled Remove References from Group Ctrl+D
T Trash

Create Group[iet
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3 A box will appear in the Groups pane.

| My Library ‘ |
|
= All References (25)
R Copied References (8)
¥, Imported References (3
(D Sync Status...
4D Recently Added (25)
Bl Unfiled (25)
TIE" Trash (8)
=~ My Groups

SR New Group Sef

4 Type in the name you want to give the group set, e.g., Thesis
5 Hit Enter to save
6 Select the Thesis group set

7 Go to the Groups menu and choose Create Group

@ EndMote X8 - [My EndMNote Library.enl] &
@ File Edit References |Groups | Tools Window Help

@@ | Harvard Create Grﬁp r»

Create Smart Group
| My Library
! Create From Groups...

8 Name this group Chapter 1

9 Right click on the Thesis group set

=l My Groups

(= Find Full Text

{5 Thesi

i - Crﬁe Group

Create Smart Group
Create From Groups...
Create Group 5et

Rename Group Set
Delete Group Set

10  Select Create Group
11 Rename this group Chapter 2

12  Create a group named Chapter 3 using either method

c. Adding References to groups

An easy way to add some of your existing references to a custom group is simply to drag
and drop the reference.
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=
My Library Search Options *
| = |
= Author ~ Contains - |HEmmgway, E
EECnpied References (®)
.!,Impwted References B And =  AnyField ~ Contains - |
@Syn( Status... And - Title * Contains A |
{‘) Recently Added (25)
Bl unfiled 25 @ @ Author B Vear  Title
T Trash @ @ Busch, Paul; Heinonen, Teiko; Lahti, Pekka 2007 Heisenberg's uncertainty principle
[ ] Harriman-Hunter, Judith 2014 Using Endnote for Bibliographies
=~ My Groups . N .
[ ] Hemingway, Ernest 1928  Men without women : stories
(= Find Full Text [ ] Hemingway, Ernest 1938 The short stories of Ernest Hemingway : the first forty-nine stories a
Hemingway, Ernest 1941 For whom the bell tolls
=) Thesis ‘——ﬂ [ ] Hemingway, Ernest 1952  The old man and the sea
Bichpter |, £=" 0)]|®  Hemingway, Emest 1994 Green hills of Africa
E_]ChapterZ L (1)} Hemingway, Ernest; Geregiannis, Nicholas; Hemingw.., 1992 Complete poems
E_] Chapter 3 ) [ ] Hemingway, Ernest; Shute, Sarah 2002 A farewell to arms
[ ] Hemingway, Ernest; White, William 2003 By-line, Ernest Hemingway : selected articles and dispatches of four
S L Y S SR T P T ECI S S

When we do this, the number to the right of the group name will change from (0) to (1),
this is displaying the number of references contained within the group.

This is not the only way to achieve this; we can also right click on a reference (or a
selection of references) and from the menu select the custom group that you wish to add
the reference to.

L] Lavery, M. P. J.; Barnett, 5. M.; Speirits, F. C.; Padget.. 2014 (Observation of the rotational Doppler shift of
L Milione, G.; Huang, H.; Lavery, M. P. J.; Nguyen, T. A... 2014 Orbital-Angular-Momentum Mode (De) Multi

Record Summary...

o Nixon, William ing EndMote from Web of Science

L Padgett, L. New Reference ample Repeated Measurement Design:
® Padgett, M. Edit References twist on the Doppler shift (vol 67, pg |
L Romero, J.; Padgett, M Move References to Trash al bound for dimensionality in high-din
° Siqueira, G. H.; Tavares, Add References To * Create Custom Group... e
L Song, W. J.; Wang, L. Z. Copy References To 5 Thesi il
® Speirits, F. C.; Lavery, M . 515 m

E-mail Reference

o Stephens, Simon Ch[:;lterl

° Svirina, Anna; Parfenov Remowve References From Group Ehapter? Ie
[ Wan, Y. Y.; Xiang, C. L. Cut Ehapters n
L] Yang. J. H.; Luo, X. P.; Z Copy ‘Fﬂwm{ﬂ

The standard selection options work in the Reference List pane (click and CTRL click for
individual references, click and SHIFT click for a consecutive list of references)

If you choose Create Custom Group, your selection of references will be added to a new
custom group. After adding them, you can then rename this group to what ever suits you

Task 7: Add References to Custom Groups

1 Click on All References

2 Select the Nixon, William — EndNote 101 reference with a single click
3 Drag the selected reference to the Chapter 1 group

4 Repeat this, but this time drag the same reference to the Chapter 2 group

The same reference can appear in as many groups as you wish!
5 While holding your control key (Ctrl) click on several random references
6 Drag this selection to the Chapter 3 group

7 Right click on any of the references in the selection
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8 From the menu that appears select Add References To — Create Custom Group

Hemingway, Ernest

Hemingway, Ernest
Hemingway, Ernest
Hemingway, Ernest

Hemingway, Emest; G

Hemingway, Ernest;
Hemingway, Ernest;

lanccane Rac

®
®
®
L] Hemingway, Ernest
e}
®
®
[ ]

Record Summary...

short stories of Ernest Hemingway : t
whom the bell tolls

old man and the sea

ten hills of Africa

Mew Reference

Edit References

Move References to Trash

Add References To 3 Qeate Custom Group...
13

Copy References To Thesis

E-mail Reference Chaoter1

9 Under My Groups, Right Click New Group

S My Groups ‘ & Author
. Hemi
Creste Group =
Heming
- Find Full Te ~ Create Smart Group Janssens
Create From Groups... Romera
=l Thesis = Speirits,
E_]Chapter ename EI':SJup
E_] Chapter Delete Group
E_] Chapter Create Group 5et

Rename Group 5et

10  Select Rename Group
11 Name the group Chapter 4
12

Drag the Chapter 4 group to below Chapter 3

=~ My Groups
=) Find Full Text

=)~ Thesis
E_] Chapter 1
E_] Chapter 2
E_] Chapter 3

@)
1
()

R 2 —
d. Creating a Smart Group

Smart groups are built with search strategies, for example, works by a particular author or

matching some subject keywords. Smart groups are dynamically updated as you add

references to and edit references in the library.

Smart Groups will sync with your Basic (Online) account, but unfortunately will not
display when you are using the web interface

1 Go to the Groups menu and choose Create Smart Group

Introduction to EndNote Desktop V1
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& EndNote X7 - [My EndNote Library.enl]
& File Edit References | Groups | Tools Window Help
w 0 | Annotated Create Group
7 Create Smart Group
My Library
Create From Groups...
= Unfiled
BTrash Rename Group
Edit Group...
- Psycho 101
= logy Delete Group
[55) Bicpsychology
{5 Clinical Psychology Add References To
5 Cognitive Psycholog Remove References From Group
ﬁ(ﬁounseling Psycholo Create Group Set
- Sodal Scences Delete Group Set
i Linguistics Rename Group Set
- Blology Hide Groups

2 Type in a descriptive name for the group

3 Type in keywords that will match some of your references

4 Select Any Field from the menu

rSmart Group —t - ol s ﬁ1
Smart Group Mame: Cognitive
Any Field ~ Contains - ICognitive E]
aAnd ~  Author » Contains - I E]
And w Title ~ Contains - I E]
[
Create ] ’ Cancel [[|Match Case [ Match Words
5 Click the Create button
Any references you have in your EndNote
Library which match the search criteria for your =+ My Groups
Smart Group will automatically be filed in the \@2, Cognition-All (33)
group, as will any future references you add. @& Cognitive 22)
Task 8: Creating Smart Groups L [T ©)
1 From the Menu select Groups — Create Smart Group
@ EndMote X8 - [My EndNote Library.enl] S I ™
@ File Edit References [ Groups | Tools  Window Help
@@ | Harvard Create Group
- . Crepte Smart Group
My Library Create From Groups...
[ — W AT O S
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2 Fill the dialog box in as follows:

rSmar‘tGrGup ﬁ1
Smart Group Name: Mixon, William
Author * Contains - |Nix0n,WiIIiam| E]

And +  VYear * (ontains hd | E]
And v Title ~ Contains - | [+
Create ] [ Cancel |:|I'~‘Ian:h Case |:|Mah\:h Words

Smart Group Name: Nixon, William

Author — Contains Nixon, William

3 Click Create

4 If you need to move the Nixon, William smart group to the Thesis group set
We can also create a smart group from an existing search:

5 Select All References

6 If there is no search panel available click Show Search Panel from the toolbar

irch C. ~ | %% Show Search Panel

¥ Show Search Panel

le Show the library search panel.

7 Search for the Author Padgett

[ Search [ Options ']

Author ¥ Contains - |Padgett
And «  Year * Contains hd |
And v Title v  Contains - |

8 Click Options — Convert to Smart Group

a Save Search ™
Window  Help Load Search

- EQ S D Set Default Q

|| [Sexch ) [Coptomss]  Restore Defaut
Author ConvertﬁSmartGroup |'[
And * Year Insert Tab |'

Insert Carriage Return

And ~ Title [

9 Right click the Converted Search smart group and rename it Padgett

10 Drag the Padgett group to the Thesis group set if necessary
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e. Managing Duplicates

It is important to try to avoid duplicates of references
in your EndNote Library. Duplicates can result in
repeat references in bibliographies and these can be
challenging to resolve. Endnote has an inbuilt tool to
help you manage duplicate references.

The Find Duplicates tool is found inside the
References menu.

When you select the command, EndNote will perform
a search of your library. It looks for and identifies any
references that it suspects are duplicates. Rather
than deleting suspected duplicates automatically,
EndNote creates a dialog box that displays side by
side the found duplicates.

The user then can compare and select which record
should be kept.

@ EndNote X8 - [My EndNote Libraryenl] 0 "

@ File Edit [References | Groups Tools Window Help

@ @ New Reference Ctrl+N
Edit References Ctrl+E
My Library
Move References to Trash Ctrl+D
Go Tou. Ctrl+J
BB Copied Refe Copy References To 3
EqSearch Resu E-mail Reference
@Sync Status,
File Attachments 3
‘:‘)RecentIyAd
B Unfiled PDF Viewer 2
nfile
Find Full Text 2
@'Trash ey
Find Reference Updates...
[=- My Groups URL b
[=- Find Full Te Figure b
2 Thesis MNext Reference Ctrl+Page Down
E_! Chapte Previous Reference Ctrl+Page Up
B} Chapte Show All References Ctrl+M
E_! Chapte Show Selected References
E_! Chapte Hide Selected References
£ Nixon, | Record Summary...
'm' Padget|

Find Duplicates %

Restore to Library

Resolve Sync Conflicts...

Empty Trash
Task 9: Managing Duplicates
To check if your Library has any duplicates,
1 Click the References menu
2 Select Find Duplicates
The Find Duplicates dialog box should appear.
@ Find Duplicates |
Comparing 1 and 2 of 2 duplicates. Skip
Select the record to keep. The record not selected will be moved to the Trash. Select Skip to go to the next set of duplicates.
Speirits, 2014 #170 Speirits, 2014 £196
Ref Type: Journal Article Ref Type: Journal Artide
Author +  |Author -
Speirits, F. C. L Speirits, F. C. L
Lavery, M. P. ). 1 Lavery, M. P. ). i
Padgett, M. J. Padgett, M. J.
Barnett, 5. M. Barnett, 5. M.
Year Year
2014 2014
Title Title
Optical angular momentum in a rotating frame Optical angular mementum in a rotating frame
Journal Journal
Optics Letters Optics Letters
Volume Volume
39 39
Issue Issue
10 - 10 -
Added to Library: 12/10/2017 Last Updated: 12102017 Added to Library: 13/10/2017 Last Updated: 13/10/2017

3 Compare the two references, you can use the sliders to scroll through all the fields

4 Click the corresponding Keep This Record button to select the record that should

be kept
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Adding Full Text

EndNote can store not just the details but also the full text PDFs of references that you
have found. You can do this in a number of ways, depending on if you already have the
reference in your EndNote library.

Find Full Text

EndNote can attempt to find and import full text (matching against the reference’s Digital
Object Identifier) from the web. To use this tool first select one or more references. Then

select References > Find Full Text, or use the Find Full Text icon on the toolbar.

EndNote will then perform a search.

o If it finds a PDF copy of the reference's text, it will download and attach it to your
reference
° It may alternately not be able to download a PDF, but will find a URL that links to it

° It may not find either the PDF or a link to it

The progress and results of the search will be displayed in your Groups pane.

Note that EndNote is unlikely to find the full text for all of your references.

Task 10: Use the Find Full Text tool

1 Select All References

2 Click on any of the references in your library
3 Use Ctrl-A to select all records in your library

4 Click the Find Full Text button from the toolbar

& Find Full Text
& Found PDF @
¢ Found URL @)

@ Mot found (21)

The search results appear as groups in your Groups pane

5 Click on the Found PDF group. (If the group exists)

-

® & | Author Year Title
® & Janssens, Bas 2017 Unifying decoher
[ ] @ Romero, J.; Padgett, M. 2014 Practical bound fi

The results displayed will have paperclips beside the references
6 Select one of the records
7 In the Tabs group, select the Attached PDF tab
8 Observe the preview of the attached PDF

9 Click on the Found URL group
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10  Double click on the Optical angular momentum in a rotating frame reference

11  Scroll down to the URL field

12  Click on the URL to see the page that contains the full text

13  Select EndNote from the Windows task bar

b. Adding PDFs to an existing record

In the last task, we attempted to find the full text for our references. Some of those

references were supplied as URL's rather than in PDF form. When this happens, we can

often download the full document and then attach it to our existing reference.

PDFs can be manually added to a reference using References > File Attachments or

with the paperclip icon in the record itself.

Task 11: Attach a PDF to

In this task, we will attach a downloaded file to the Optical angular momentum in a
rotating frame reference. The file is already downloaded to your practice files folder

areference

1 Click on the Found URL group

2 Select the Optical angular momentum in a rotating frame reference

3 Select References — File Attachments — Attach File
B Endote X8 - My Endiiote Lire T2 I

@ File Edit [References | Groups Tools Window Help

@@ New Reference CtrieN ‘@ ®| ‘ [ B E’E\ (2
e Edit References Ctrl+E
My Library
- Move References to Trash
{2 All Referenc .
F Go To... Crl+) ~ Contains - m
:BCopied Refe ¢4y References To , Contai —
F - ontains -
E8 Search Resu E-mail Reference
(@D Sync Status. »  Containe -
DRecently Ad File Attachments b Attach File... Ctrl+Alt+A
ecently
) Unfiled PDF Viewer v Ope File Cirl+Alt+P
nTile
= Trash Find Full Text 3 Save As... Ctrl+Shift+5
rasi
- Find Reference Updates... Convert to Relative Links
= LyEmTs URL v Rename Attachment...
= Find Full Tef Figure 3 Rename PDFs...
- r

4 Navigate to your practice folder (Your instructor will tell you where to find it if you are

@ Select a file to link to the reference i
Look in: Endnote - @7 > @E
Nane ° Date modified Type

N Import from folder
Recent Places  f5110 10073:2F978-3-642-13636-8.pdf

! T 01-39-10-2044.pdf

12/10/2017 11:49 File folder
04/08/2017 08:51 Adobe Ac
10/10/2017 15:47 Adobe Ac

Desktop
=
Libraries
Computer
C,
“
Network < ¥
Files of type: All Files (") b ‘ | Cancel ‘

| Copy this file to the defautt file attachment folder and create a relative link.
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5 Select the file named 0l-39-10-2944.pdf

6 Click Open

The PDF will become available in the Attached PDF tab. Note that the reference
does not save until you select another reference within EndNote

7 Select another reference

Importing PDFs into EndNote

If you have a PDF, you can import it directly into EndNote and EndNote will create a
reference for it. The quality of the data in the reference will depend on whether the PDF
has a Digital Object Identifier (DOI) on the first page and that EndNote correctly identifies
it.

Author manuscript

. HHS Public Access
v

J Chem Educ. Author manuscript; available in PMC 2017 July 12.

Published in final edited form as:
J Chem Edue. 2016 July 12; 93(7): 1316-13{9. doi:10.1021/agk.jchemed.6b00262.

If EndNote cannot identify the DOI, It may create a blank record and you will need to add
the details manually.

You can import PDF's file-by-file into Endnote, or you can attempt to import an entire
folder.

Task: Import PDF's into Endnote

1 Click on the import button © in the toolbar.
EQ e Q| |2 B®E 0.
] e & imF.D:'"f fre fil ito this lib L

withar ¥ fanfaing ¥ TPRARET

2 Change Import Option to PDF.
Import File ‘ P |

Import File: [ Choose...

PDF -

Import Option:

Duplicates: [Discard Duplicates -]

Text Translation: o Transiation -

Cancel

3 It is also recommended that you set Duplicates to Import into Duplicates Library.
This will avoid duplicates being added into your main library.

4 Click on the Choose... button

The open dialog box will appear

5 Navigate to your practice files folder

Introduction to EndNote Desktop V1.1
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6 Select the Arrizabalaga-2017-Fabrication of an Economical.pdf file
7 Click Open

8 Click Import

9 Double click the now imported reference and examine the fields

10  Close the newly imported reference

Task 13: Import a folder

Importing PDFs a file at a time is time consuming, especially if you have collected many
PDFs. In this task, we will import a folder.

1 Select File — Import — Folder
) EndNote %6 - My Endhiote Library.<ni] AR

@[File] Edit References Groups Tools Window Help

B - Qs oa
E Open Library... Crl+Q —
8 || Cpen Sharexd Librory. Cutteshitero L
= Open Recent * Buthor
e
& Close Library Cul+W  Year
£l Save cil-s  Title
@ Save As...
o) Save a Copyu. hor
B Revert kabalaga, Julien H.; Simm
|
= Share...
Export..

=)
= Import v File...
Print... Ctrl+P Flider..

2 Make sure the Import Option is set to PDF

Import Folder l D
Import Folder: | Choose...

[ Indude files in subfolders
[ Create a Group Set for this impart

Import Option: [P -]

Duplicates: [rmport Al -]

Cancel

3 Tick Include files in subfolders
4 Set the Duplicates to Import into Duplicates Library
5 Select Choose

6 Navigate to your practice folder
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7

10

11

12

13

14

Select the folder named Import from folder
Browse For Folder @1

Impart Folder

Crmis13.2.10 =
Course Introductions.
. Drew

4 | Endnote

mn

Import from folder
Excel 2010 - Filters, Functions and moi
Excel 2010 Huntarian
. Excel 2016 - Datalists, PivetTables and
. Excel 2016 - Graphs & Charts

Excel Intraduction

< . r

Make New Folder ] l 0K ] [ Cancel
Click OK
Click Import
i ===

After a short wait, the PDFs will import into new references.

One of our imported PDFs does not have a readable DOI; unfortunately, its

reference is not complete

Double click the incomplete reference

® @ Author Year Title

L ¥ <Reducing Uncertainty.pdf>

® & Grinias, ). P; Whitfield, J. T.; Guetschow, E% Kenn.. 2016  AnInexpensive, Open-Source USB
[ ] @ Haniszewski, Tomasz 2016 ‘Conception of the Arduino Platforn
® @ Schultz, B.G.;vanVugt,F.T. 2016  Tap Arduino: An Arduino microcont
® & Zabala, Gonzalo; Moran, Ricardo; Teragni, Matias; BL.. 2017 On the Design and Implementation

Click on the Layout button on the bottom left corner of the Endnote Application

'\ PDF Panel

Right

off

If it is not already ticked, select Right

Drag the split pane so that the PDF preview is

large enough to read easily

Skl

=&

X

'@Reducing Uncertainty.pdf | @

MESE|CD: 5[0 ® o -

»

Redueing Uneertalniy: Implemestation of Heissnbers Principle 0 Measure
Comy e

“h

Highlight the title Reducing Uncertainty: Impl

m

ementation of Heisenberg Principle

to Measure Company Performance on the PDF

Introduction to EndNote Desktop V1.1

27



15  Right hand click the title and choose copy

16  Paste the title into the Title field on the right hand side of the screen.

You can fill in many of the fields with information gleaned from the PDF file if you
need to.

Creating a Bibliography: Using Cite while you write
EndNote works with Word to easily and quickly cite references, and create a paper with

properly formatted citations, a Bibliography, figures, and tables.

This is all done using the EndNote X8 ribbon, which you will see in Word once you have
installed EndNote Desktop on your PC.

File Home Insert Design Layout References Mailings Review View EndMote XB Q@ Tell me what you want to do...

[}) @ Goto EndNote Style: | Annotated - ﬁ& Categorize References - Export to EndNote ~

T F",‘Edit&l\danage Citation(s) LE,' Update Citations and Bibliography In:tant Formatting is On = __=_Preferences
nsert
Citation = E‘¢Edit Library Reference(s) E'\Con'.fert Citations and Bibliography = oHeIp

Citations Bibliography 7} Tools

The EndNote X8 ribbon will look like this

If you cannot find the EndNote X8 ribbon, please contact the IT Services Helpdesk via
https://www.gla.ac.uk/myglasgow/it/helpdesk/

Inserting Citations and Bibliographies into a document

The first time we add an EndNote Reference to a document it typically will take a bit of
time. After that, references are added more or less instantly.

There are several different methods for adding a reference to a document we namely:

° Using the Insert Citation button from the EndNote X8 ribbon
° Using the Insert Citation button in the EndNote application
o Typing the reference details within {} curly brackets

No matter what method you do, providing that Instant Formatting is On (A setting in the
EndNote X8 ribbon), the reference will be added, formatted and an endnote
generated/updated.

We can also edit citations to include prefixes, suffixes and page numbers should the
referencing style we are using support this.

Task 14: Inserting Citations into a Word Document
2 From the EndNote practice files folder open Chapter 3.docx Word document

3 Position your cursor where you wish to place a citation in the text. Remember to
leave a space between the last character and your cursor, and ensure that your
citation is placed before the full stop at the end of a sentence

4 Click the Go to EndNote button from the EndNote X8 ribbon

You will be taken to the EndNote application
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10

11

12

13

14

Select the Chapter 3 group from the Thesis group set

= Thesis
B Chapter1 fub]
B Chapter2 (o))
B Chapter4 )

Select the reference you want to use

Click the Insert Citation button IEI

In a short while you will return to the Word document — the citation will now have
appeared

If the citation is unformatted (i.e. in curly brackets) click the Instant Formatting is
Off button and choose Turn Instant Formatting On

Select the style you want from the Style menu

Style: | Annotated -

[Z! Up Select Another Style...

B2 cg Annotated
apasly
Author-Date

Position your selection where you wish to place the next citation in the text.

Click the Insert Citation button in the EndNote X8 Ribbon

2
File Home Insert

55 @ Go to EndNote
» Edit anage
[ Edit & Manage C

Insert
I| Citation - [ Edit Library Refen

‘I Citations

In the Find & Insert My References dialog box, fill in the search box with the name
Padgett

r = 3
EndNote X8 Find & Insert My References |
Podget] -1 e
Author Year Title
Speirits 2014 Optical angular momentum in a rotating frame
Padgett 2014 A& new twist on the Doppler shift (vol 67, pg 58, 2014)
Lavery 2014 Observation of the rotational Doppler shift of a whiteight, orbital-angular-momentum-carrying beam backscattered|
Padgett 2014 One-Sample Repeated Measurement Designs
Milione 2014 Orbital-Angular-Momentum Mode (De) Multiplexer: A Single Optical Element for MIMO-based and non-MIMO-based b
Siqueira 2014 Performance evaluation of natural rubber seismic isolators as a retrofit measure for typical multi-span concrete bridc|
Romero 2014 Practical bound for dimensionality in high-dimensional entanglement
i
< [ . N r
Reference Type:  Journal Article -
Record Number: 170
Author: Speirits, F. C. =
Lavery, M, P. 3.
Padgett, M. 1.
Barnett, S. M.
Year: 2014
Title: Optical angular momentum in a rotating frame
Journak Optics Letters
Volume: 39
Issue: 10
Pages: 2944-2946 v
[ st -] [ cancel ][ e
Library: My EndNote Library.enl 7items in list

Click Find
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15  Select two references from the list that appears (hold the Ctrl key to make a multiple

EndNote X8 Find & Insert My References [
— - — - PR -
=
Author Year Title
Speirits 2014 Optical angular momentum in a rotating frame
Padgett 2014 A new twist on the Doppler shift (vol 67, pg 58, 2014)
Lavery 2014 Observation of the rotational Doppler shift of a white-light, orbital-angular-momentum-carrying beam backscattered
Padgett 2014 One-Sample Repeated Measurement Designs
Milione 2014 Orbital-AngularMomentum Mode (De) Multiplexer: A Single Optical Element for MIMO-based and non-MIMO-based
iSiqueira 2014 Performance evaluation of natural rubber seismic isolators as a retrofit measure for typical multi-span concrete bridg
Ramero 2014 Practical bound for dimensionality in high-dimensional entanglement
< | [ 3
I
U
[ Insett \ - ] [ Cancel ] [ Help
Library: Fitems in list

17  You should now have a correctly formatted citation and a bibliography at the end of
your document (scroll to the end to see the bibliography)

Milione, G., Huang, H., Lavery, M. P. J., Nguyen, T. A., Xie, G. D., Cao, Y. W., .
. . Willner, A. E. (2014). Orbital-Angular-Momentum Mode (De)
Multiplexer: A Single Optical Element for MIMO-based and non-MIMO-based
Multimode Fiber Systems. 20714 Optical Fiber Communications Conference
and Exhibition (Ofc).

Padgett, L. (2014). One-Sample Repeated Measurement Designs. Repeated
Measurements and Cross-over Designs, 25-52. doi:Book_Doi
10.1002/9781118709153

Speirits, F. C., Lavery, M. P. J., Padgett, M. J., & Barnett, 5. M. (2014). Optical
angular momentum in a rotating frame. Optics Letters, 39(10), 2944-
2946. doi:10.1364/01.39.002944

b. Editing a Reference

Once you have a reference into a document, you can edit it to include additional
information such as page numbers, a prefix or suffix.

Select the reference that you wish to edit and select Edit & Manage Citations
=)

EndNote X8 Edit & Manage Citations

Citation Count  Library
(Padgett, 2014)
Padgett, 2014 #173 1 My EndMote Library

Edit Reference | ~

(Milione et al., 2014; Speirits, Lavery, Padgett, & Barnett, 2014)

4| Speirits, 2014 #170 1 My EndNote Library
|
t Miione, 2014 #175 1 My EndMote Library Edit Reference | -

Edit Citation | Reference

Fommating:

Prefix:

Suffix: I
Pages:

) ) (i) |
Totals: 2 Citation Groups, 3 Citations, 3 References |
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Fill in the fields that you wish to edit and click OK. If the Instant Formatting is on, you
should see your edits appear. If the edits do not appear, the style that you are using does
not support the additional information.

Task 15: Adding Page Numbers to a Reference

1

2

Change the Style to APA 6! in the EndNote X8 ribbon
Click on the first reference in your word document

Click Edit & Manage Citation(s) in the EndNote X8 Ribbon
In the Pages field type 113

Click OK
The reference will update with the addition of p. 113
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Appendix 1
Endnote Basic (aka Online or Web)

EndNote Basic is a FREE Web version of EndNote, which you may prefer to use off-
campus.

Groups of records can be transferred easily between EndNote X8 Desktop and EndNote
Basic, so you may choose to use the full software when you are in the University and the
online version when you are at home. It is highly recommended that you use EndNote
Basic to back up your EndNote references. You can also use EndNote Basic to share
references and work collaboratively with others.

EndNote Basic provides 2GB of storage for attachments. However when you sync this
with the Desktop version of EndNote you will be upgraded to a full account with unlimited
storage space.

The upgraded account stays for two years from the point at which they are synced, after
which time the web version reverts to “Basic”, however no references are lost. The
account is upgraded for a further two years when it is linked to the latest version of
EndNote Desktop.

a. Registration

The first time you use EndNote Desktop you will be prompted to create an online account;
this is probably the easiest method to create an account. It will also set up sync for you at
the same time

Once you have registered, you can go to www.myendnoteweb.com and access the web
based EndNote Basic

Alternately, you can register for an account at the above web address.
b. Using EndNote Basic

Once you log in you will be EndNote Basic home page.

£33 EndNote x

< C | ® www.myendnoteweb.com/EndiateWeb him w @ e v X

i Apps ¢ Bookmarks Training Resources Admin Website [ Addtolist [ Capture Reference Home Automation Pi [3 Capture Reference Other bookmarks

Thomson Reuters

EndNote™ MyReferences  Collect ~ Organize  Format Match  Options  Downloads

Hide Getting Started Guide

Quick Search Getting Started

|Search for

in| All My References v
® D ﬁ-"}
¥ Find Store & Share % Create

My References
All My References (31)
[Unsied] (20) Collect references by searching Organize and group references in any Use our plugin to format
Quick List (0) online databases or importing your way that works for you. Then share bibliographies and cite references
existing collection. your groups with colleagues. while you write.

z
3
T

Trash (3) Empty
'V My Groups o Search an online database o Create a new group o Cite While You Write™ Plug-In

Chapter 1 {1} s Create a reference manually = Share a group o Create a formatted bibliography
Chapter 2 (1)
Chapter 3 (5)
Chapter 4

s Import references e Find duplicate references o Format a paper
o EEE Fing your best potential
Jjournal

Build a profile to showcase
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http://www.myendnoteweb.com/

Note that initially the header of this page is EndNote Basic — when you sync your Library

with EndNote Desktop, the basic disappears from the header (bottom image) and it

displays just EndNote.

If you click on Hide Getting Started Guide (top right of the page), you will see your online

EndNote Library

£33 EndNote x

< C | @ www.myendnoteweb.com/EndNoteWeb.htmi

i Apps Y Bookmarks Training Resources Admin Website

Thomson Reuters

t MyReferences  Collect ~ Organize  Format

Quick Search
Search for

All My References

in| All My References v Show 50 per page ¥

Hide panel

Search
. Al Cpage

My References
Authors

All My References (31)
[Unfiled] (20)
Quick List (0)

Trash (9) Empty

W My Groups.
Chapter 1 (1)
Ghapter 2 (1)
Chapter 3 (5)
Chapter 4 (5)

Arrizabalaga, Julien H.

Build a profile to showcase
yourowawork Busch, Paul
(

[ Addtolist [4 Capture Reference

Match

Home Automation Pi

[} Capture Reference

Options  Downloads

M« Page 1 of1 Go MM

dd to group... ¥ | Copy To Quick List | Delete

Year Title

2015
SYSTEMICS, CYBERNETICS AND INFORMATICS
Added to Library: 13 OCt 2017  Last Updated: 13 Oct 2017

& Eruiien]

Fabrication of an Economical Arduino-Based Uniaxial Tensile Tester
Journal of Chemical Education
Added to Library: 13 Oct 2017  Last Updated: 13 Oct 2017

& Eruien]

Heisenberg's uncertainty principle

Physics Reports

Added to Library: 12 OCt 2017  Last Updated: 12 Oct 2017
Online Link= Go to URL

wmZ Full Text| Fuitext

2017

2007

Reducing Uncertainty: Implementation of Heisenberg Principle to Measure Company Performance

[ (= [© [

*B Qe v % :

Other bookmarks

Show Getting Started Guide

Workingona goup ¢
Project? Check out [EN
8

Library Sharing on X

Sort by:[First Author —~ A to Z

c. Configuring EndNote Desktop to sync

To configure EndNote Desktop to sync with EndNote online you first need to enable this

feature.

In EndNote Desktop go to Edit > Preferences and then select Sync from the left hand

menu of options.

(oo o s B R e

Change Case Synchronize your data with your EndNote account. Leam more
- Display Fields

Display Fonts Upgrade or create your twoyear EndNote accourt to get the latest features
Duplicates and enable Sync.

Find Full Text

Folder Locations

Formatting

Libraries

PDF Handling EndNote Account Credentials

Read / Unread

E-mail Address: l . »@glasgow ac.uk

Reference Types

Sorting Password: =

Spell Check

Temporary Citations Sync this EndNote Library

Term Lists

\\cfsj06.campus gla.ac.uk\SSD_Home...\My EndNote Library.enl
URLs & Links i weg - i 2
[¥] Sync Automatically
[ EndNote Defauts | [ RevertPanel | Aoy

Provide your Endnote online login and password, if you do not already have one when you
click on Enable Sync you will be offered the chance to create an account.
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o =

te account makes it easy to keep your EndNote library in sync.

i

Create a new EndNote Account

If you don't have an EndNote account or aren't
sure, then dick Sign Up.

EndNote Account Credentials
E-mail Address: - @alasgow.ac.uk
Password: sssccseces

Forgot Password

Click on OK and EndNote Desktop will connect to EndNote online and import any records
to the desktop version. If there are already records in the EndNote Desktop database,

EndNote will warn you and will merge them.

d. Installers and Web Capture Tool

EndNote Basic has a number of free downloads available including a Capture Reference
to capture web pages and Cite While You Write plug-ins for Windows and Apple Mac.

These are available at Downloads

My References  Collect  Organize Format Match Options

Cite While You Write™

Use the EndMote plug-in to insert references, and format citations
and bibliographies automatically while you write your papers in
Word. This plug-in also allows you to save online referances to
your library in Internet Explorer for Windows.

U.S. Patent 8,082,241

See Installation Instructions and System Regquirements.

Download Windows with Internet Explorer plug-in
Download Windows MSI for mass program installation
Download Macintosh

Downloads

Capture: Capture Reference

To install the Capture tool, just drag the Capture Reference
button to your Bookmarks bar (also known as "Favorites Bar" or

"Bookmarks Toolbar"). In some browsers, you may need to right-

click and select "Add to Favorites" or "Bookmark This Link."

To use it, browse to a page you like and click the Capture
Reference button in the Bookmarks bar. The Capture Reference
window will open. Follow the instructions in the window.
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Appendix 2
Advanced Preferences: Find Full Text

To enable Find Full Text if you are using EndNote Desktop on a PC or laptop off-campus
you need to provide the University’s EZproxy URL

1

2

Select Edit - Preferences - Find Full Text

In the URL field under Authenticate with: add

ezproxy.lib.gla.ac.uk/login

Then click on Apply

oo S —

Change (Fase The Find Full Text feature uses several technologies to maximize the
- Display Fields chances that EndNote will find all available PDFs. Use this screen to
. Display Fonts control these full text search options:
Duplicates [#] Web of Science Full Text Links
.. Find Full Text
.. Folder Locations DOl {Digital Object Identifier)
- Formatting PubMed LinkOut {L1.5. National Library of Medicine)
- Libraries
. PDF Handling [C10penURL
. Read / Unread OpenUAL Path:
- Reference Types pen :
Sorting Autherticate with:
- Spell Check
- Syne URL: http://ezprocy lib.gla.ac ukogin
Tempn.rary Citations Examples: hitps://ogin ezproxy library myuniversity.edu.login
- Term Lists http://auth universityname .edu/authentication
- URLs & Links

|¥] Automatically invoke Find Full Text on newlyimported references

[ EndNote Defauits | [ Revert Panel | [ ok

][ Cancel ][

Apply

In EndNote, right click on a record and select Find Full Text > Authenticate.

Login with your GUID

e ——
il t
ifn Unliiél‘Sl y
7 of Glasgow
The resource you have attempted fi
to access requires that you log in Theuk
. . Access
with your University of Glassawr (B hyert 1
credentials. GUID Federation I
i
Password
| o
» GUID for Students
7 Helpdesk

7 Click Done

Note: Depending on the record and availability of the PDF not all searches will return
full text.
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Appendix 3
Generating a combined Bibliography, having
merged all Chapters of a Thesis

a. Method 1

If you create your thesis work in individual chapters, you will then require to combine all
chapters (placing section breaks between each - the Bibliography for each chapter will
appear at the end of each section).

1 You should then cut the Bibliography at the end of the last chapter inserted (e.g.
chapter 5) and paste it at the point in the combined file where you wish the full
Bibliography to appear.

2 From that point, you then click Update Citations and Bibliography on the EndNote
tab. The full Bibliography will be generated at this point.

3 Check all references are correct and featured in this new full Bibliography, then
delete those at the end of each chapter.

b. Method 2

1 In each Chapter, from the EndNote X8 ribbon choose the drop down arrow on
Convert Citations and Bibliography and click Convert to Unformatted Citations.

All citations will be converted and the automatic bibliography at the end of each
document will disappear.

2 Re-save each chapter.

3 Then, once you have combined all chapters together, sit at the point in the combined
file where you wish the full Bibliography to appear.

4 Click Update Citations and Bibliography on the EndNote tab.
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Useful Shortcut keys

Function

Creates a new reference
To select more than one reference
Selects a range of references
Opens selected references
Closes the active window
Selects the next field
Selects the previous field
Open Library

Close Library

Save

Exit

Undo

Cut

Copy

Paste

Select All

New Reference

Edit References

Move References to Trash
GoTo

URL > Open URL

Next Reference

Previous Reference

Show All References
Search Library

Help Contents

Shortcut
Ctrl + N

Ctrl + Click
Shift + Click
Ctrl + E

Ctrl + W
Tab

Shift + Tab
Ctrl+O
Ctrl+W
Ctrl+S
Ctrl+Q
Ctrl+z
Ctrl+X
Ctrl+C
Ctrl+V
Ctrl+A
Ctrl+N
Ctrl+E
Ctrl+D
Ctrl+J
Ctrl+G
Ctrl+Page Down
Ctrl+Page Up
Ctrl+M
Ctrl+F

F1
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